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Introduction 

 

 

 

indows 7 is Microsoft’s newest operating system. 

If you are looking to add a personal touch to your 

installation of Windows 7, this book will help you get 

started. 

There are thousands of customizations you can apply 

and this pocket guide only scratches the surface. As 

always, I’ve written this book so anyone can pick it up 

and work through it. 

I recommend you begin by reading the Getting Started 

chapter; this chapter will give you a good foundation 

for the rest of the book. A basic knowledge of how 

Windows works is required to follow most of the 

guides; however, if you are very new with computers, I 

am still confident you will learn a lot as you go through 

this book – taking things one step at a time. 

W 
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Once you have read Getting Started chapter, you’re 

ready to explore the rest of the book and personalize 

your machine to match your style. 

I’m sure there’s something here for everyone; take a 

browse through the contents page and see what strikes 

your interest. You do not need to read this book in 

order; feel free to explore. 

If you have questions or feedback, head to the Contact 

Me section at the end of this book and get in touch 

with me. 

If this version of the book seems a little dated, head to 

Windows Guides for an updated version. 

I began writing this book as soon as the public beta 

came out. I felt this was a good time to start getting 

familiar with the features that would soon be ready 

with the released version of the operating system. 

However, as features are updated, some of these 

guides may no longer work exactly as stated. I will 

continually update this book and make sure that it's 

ready for the final release of Windows 7. 

 

http://mintywhite.com/tech/books/
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1.0 Get Started 

 

 

 

efore you get started with this book, there are a 

few questions you should ask yourself: 

 Should I install Windows 7 and still keep Vista or 

XP on my computer? 

 Should I use the 32 or 64 bit version of Windows 

7? 

This chapter addresses these questions and helps you 

formulate the answers that best suit your needs. 

   In the latter half of this chapter, you’ll learn about 

the Windows Registry and Group Policy Editor.  

   Enjoy working through this book and remember: 

More is less when you customize your system; don’t 

try to change every last thing. Make changes that look 

good and keep your system clean and tidy. 

B 
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1.1 Windows 7 System Requirements 

As the current version of Windows 7 is still not the final 

version, the system requirements are subject to 

change. However, the current minimum system 

requirements are as follows: 

 1 GHz 32-bit or 64-bit processor 

 1 GB of system memory 

 16 GB of available disk space 

 Support for DirectX 9 graphics with 128 MB 

memory (to enable Aero theme) 

 DVD-R/W Drive 

I’ve tested Windows 7 with 512MB of RAM and found it 

to work well; however, I do not recommend running 

with such low memory – unless you really have to. 

 

1.2 Windows 7 32 or 64-bit? 

When deciding to move up to a 64-bit operating 

system, you should first consider what 64-bit gets you. 

Knowing what software runs on 64-bit should influence 
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your decision; you will see no advantage if you are 

running 32-bit software on a 64-bit OS. You also lose 

the ability to run 16-bit software, which shouldn’t be a 

problem unless you rely on older software, such as old 

work software or home-made packages you haven’t yet 

updated. 

 

1.2.1 What Does 64-Bit 7 Get Me? 

More bits gets you access to more memory; the 

processor inside your PC communicates with your 

system memory (RAM) with numeric addressing. Thus, 

the maximum amount of memory a 32-bit processor 

can address is 4 gigabytes. Newer 64-bit processors—

not to mention the 64-bit operating systems that run 

on them—can address 17,179,869,184 gigabytes (16 

exabytes) of RAM. 

Windows NT, released in 1993, was Microsoft’s first 

fully 32-bit operating system; however, it took eight 

years before the platform, which had since evolved into 

Windows 2000 and then XP, became mainstream. (Yes, 

Windows 9x ran 32-bit applications, but it was a hybrid 

OS that ran on a 16-bit DOS foundation, which was one 
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of the reasons it was so unstable.) 64-bit Windows 

became a reality in XP, and Vista was Microsoft’s first 

serious attempt to make 64-bit computing mainstream. 

I am sure more people will use Windows 7 64 bit 

because of the increasing demands for more RAM. The 

question is: how mainstream is 64 bit? 

 

1.2.2 How Mainstream is 64 bit? 

While 64-bit 7 can run most 32-bit applications without 

a problem, it’s not compatible with 32-bit hardware 

drivers or 32-bit utilities like Windows Explorer 

extensions (e.g., context menu add-ons.) This means 

you need a native 64-bit driver for every device on your 

PC; finding support for all your hardware may be a bit 

of a challenge, at least on older computers 

 

1.2.3 Is there a Performance Increase? 

Now, 64-bit software running on 64-bit Windows has 

been known to run as much as 10% faster, which 

illustrates the other reason—aside from memory 

addressing—that people find 64-bit 7 alluring. Just be 
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prepared for lackluster industry support, at least for 

the next few years until Microsoft releases a 64-bit-only 

OS. 

 

1.3 Install Windows 7  

Now you’ve decided which version of Windows 7 to 

use, you’ll want to get it installed on your PC. You have 

three options: 

 Upgrade from Windows Vista 

 Dual boot with XP or Vista 

 Install Windows 7 from scratch 

Learn how to do each of the above in this section. 

 

1.3.1 Upgrade to 7 from Windows Vista 

Upgrading is the easiest option of the three. However, 

upgrading can take a long time. To upgrade to 

Windows 7 from Windows Vista, do the following: 

1. Insert the Windows 7 DVD into your DVD-ROM 

drive 
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2. Click Run setup.exe from the Autoplay menu 

 

3. Click Install now on the Install Windows screen 
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4. Setup will begin by copying files to your 

computer 

 

5. I recommend you get updates online before 

upgrading Windows 
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6. Accept the license terms and click Next 

 

7. Now click Upgrade and follow the instructions. 

You may get a compatibility report, which will help you 

determine what may not work properly after the upgrade. 
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1.3.2 Dual Boot Windows XP/Vista with 7 

Dual booting Windows is the most challenging of the 

three options; however, making it work can be very 

rewarding. The process of creating a dual boot 

environment differs from Windows Vista to XP. Please 

follow the instructions according to which version of 

Windows you are currently using.  

To run two operating systems on your computer, you 

will need to add a second partition. If you are not 

familiar with adding a partition, you can learn how in 

this section. 

 

1.3.2.1 Dual Boot Windows XP with Windows 7 

You will need third party software to create a second 

partition for Windows 7. Once you have created the 

partition, you may install Windows 7 on it. 

Creating a New Partition 

To create a second partition on your hard drive in 

Windows XP, do the following: 

1. Download the GParted live CD here 

http://gparted.sourceforge.net/download.php
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2. Burn the image to a CD, reboot your computer, 

and boot from the CD. (How to burn an ISO to a 

disc) 

3. Once you’ve booted into GParted, create a 

partition for Windows 7 (16 GB+ recommended) 

(How to create a partition with GParted) 

4. Refer to the Install Windows from Scratch 

section of this chapter to learn how to install 

Windows 7 on your newly created partition. 

 

1.3.2.2 Dual Boot Windows Vista with Windows 7 

Windows Vista natively manages partitions; you will 

need to create a second partition for Windows 7. Once 

you have created the partition, you may install 

Windows 7 on it. 

Creating a New Partition 

To create a second partition on your hard drive in 

Windows Vista, do the following: 

1. Press the Start button, right click Computer, and 

select Manage 

http://mintywhite.com/tech/windows-7/burn-the-windows-7-iso-to-a-dvd-how-to/
http://mintywhite.com/tech/windows-7/burn-the-windows-7-iso-to-a-dvd-how-to/
http://mintywhite.com/tech/windows-7/burn-the-windows-7-iso-to-a-dvd-how-to/
http://www.howtoforge.com/partitioning_with_gparted
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2. In the left pane, click Disk Management 

 

3. Now create a new partition by shrinking a 

previous volume. Right click on the partition and 

select Shrink Volume 
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4. Input the size, in MB, you want to shrink the 

partition by (16 GB = 16,384 MB) 

 

5. Now right click the free space and click New 

Simple Volume… 

 

6. Click Next 
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7. Select the volume size and click Next 

 

8. Assign a letter to the drive and click Next 
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9. Format the drive as NTFS, give it a label, and 

click Next 
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10. Click Finish 

 

11. Refer to Install Windows from Scratch to learn 

how to install Windows 7 on your newly created 

partition. 

 

1.3.3 Install Windows from Scratch 

Whether you are installing Windows 7 on a blank hard 

drive or a newly created partition, the procedure is the 

same.  

To install Windows 7 from scratch, do the following: 
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1. Turn your computer on, insert the Windows 7 

DVD, and restart your computer 

2. Press the necessary key to initiate booting from 

your DVD (usually ESC or F12.) If you are unsure 

how to do this, please refer to your 

manufacturer’s website or computer’s manual. 

3. Windows will now load the installation files. 

 

4. Click Install now 
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5. On the Get important updates for installation 

page, I recommend getting the latest updates to 

help ensure a successful installation and protect 

your computer against security threats. You need 

an Internet connection to get updates 

6. On the Please read the license terms page, if you 

accept the license terms, click I accept the 

license terms. (You must accept to continue the 

installation.) 

7. On the Which type of installation do you want? 

page, click Custom 

8. On the Where do you want to install Windows? 

page, do one of the following 

a. If you don't want to specify a partition to 

install Windows on, or create partitions on 

your hard disk, click Next to begin the 

installation 

b. OR If you already have another existing 

partition with enough free space and want 

to install Windows 7 on that partition to 

create a multi-boot configuration, select 
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the partition you want to use, and then 

click Next to begin the installation. (Be 

sure to install Windows 7 on a different 

partition from where your current version 

of Windows is installed.) 

9. Windows will take some time to install, so be 

patient 

 

10. Your computer will restart several times during 

the process. Be sure to leave the DVD in the 

drive and let Windows take care of itself 
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11. After some time, Windows will now be installed. 

If you are running a dual boot, you should have 

the choice of either version of Windows when 

you turn your computer on. 

 

1.4 About the Windows Registry 

Throughout this book, some guides require you to 

access the Windows Registry and make changes. I try 

to make executable registry hacks in most cases, but it 

can be fun to script or create your own registry files. 

Before doing anything with the Windows Registry, you 

should know what the registry is, how to back it up, 
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how to restore it to a previous state, and how to add 

keys and values. 

 

1.4.1 What is the Windows Registry? 

Think of the Windows registry as a control center for 

your computer. Windows settings, individual program 

settings, and other important configuration 

information are stored here. 

 

1.4.2 Access the Windows Registry Editor 

To access the Windows Registry, press the start button, 

type regedit, and press Enter. 

 

The registry is made up of the following components: 

 Keys 

 Subkeys 

 Values 
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1.4.3 Add Keys or Values 

In some of the tutorials in this book, you will need to 

create a new key or value. 

 

1.4.3.1 Add a New Key 

To add a new key, do the following: 

1. Right click on the parent key 

 

2. Select New > Key 

 

 

 

3. Follow the guide’s instructions for what key 

name to assign 

 

1.4.3.2 Add a New Value 

To add a new value, do the following: 

1. Navigate to the key that you want to add a value 

to 
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2. Right click in the blank space of the right pane  

 

3. Select New > xx (Where xx is the value specified 

in the guide) 

 

 

 

4. Follow the guide’s instructions for what value to 

assign 

 

1.4.4 Back up the Registry 

To back up the registry, please refer to the Back up 

Your Data chapter. 

 

1.5 About the Group Policy Editor 

Group Policy is a feature of Microsoft Windows that 

provides centralized management and configuration of 

computers. 
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Please Note: The Group Policy Editor is not included 

with every version of Windows 7 and is currently only 

available in Windows 7 Ultimate. 

 

1.5.1 Access the Group Policy Editor 

Press the start button, type gpedit.msc, and press 

Enter. 

 

 

1.5.2 Work with the Group Policy Editor 
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To enable options (as directed in any of the guides), 

double click on the specified option in the right-hand 

pane, and change the setting to Enabled. 

 

 

1.6 You Are Ready to Begin 

You made it this far and now you are ready to begin. 

As a brief recap, you learned the requirements of 

Windows 7, the version to install, and how to install 

your chosen version. You also learned about the 

Windows Registry and the Group Policy Editor. I 

strongly suggest you review the Back up Your Data 

chapter, but you are now free to explore the book. 
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1.0 Get Started 

 

 

 

efore you get started with this book, there are a 

few questions you should ask yourself: 

 Should I install Windows 7 and still keep Vista or 

XP on my computer? 

 Should I use the 32 or 64 bit version of Windows 

7? 

This chapter addresses these questions and helps you 

formulate the answers that best suit your needs. 

   In the latter half of this chapter, you’ll learn about 

the Windows Registry and Group Policy Editor.  

   Enjoy working through this book and remember: 

More is less when you customize your system; don’t 

try to change every last thing. Make changes that look 

good and keep your system clean and tidy. 

B 
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1.1 Windows 7 System Requirements 

As the current version of Windows 7 is still not the final 

version, the system requirements are subject to 

change. However, the current minimum system 

requirements are as follows: 

 1 GHz 32-bit or 64-bit processor 

 1 GB of system memory 

 16 GB of available disk space 

 Support for DirectX 9 graphics with 128 MB 

memory (to enable Aero theme) 

 DVD-R/W Drive 

I’ve tested Windows 7 with 512MB of RAM and found it 

to work well; however, I do not recommend running 

with such low memory – unless you really have to. 

 

1.2 Windows 7 32 or 64-bit? 

When deciding to move up to a 64-bit operating 

system, you should first consider what 64-bit gets you. 

Knowing what software runs on 64-bit should influence 
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your decision; you will see no advantage if you are 

running 32-bit software on a 64-bit OS. You also lose 

the ability to run 16-bit software, which shouldn’t be a 

problem unless you rely on older software, such as old 

work software or home-made packages you haven’t yet 

updated. 

 

1.2.1 What Does 64-Bit Vista Get Me? 

More bits gets you access to more memory; the 

processor inside your PC communicates with your 

system memory (RAM) with numeric addressing. Thus, 

the maximum amount of memory a 32-bit processor 

can address is 4 gigabytes. Newer 64-bit processors—

not to mention the 64-bit operating systems that run 

on them—can address 17,179,869,184 gigabytes (16 

exabytes) of RAM. 

Windows NT, released in 1993, was Microsoft’s first 

fully 32-bit operating system; however, it took eight 

years before the platform, which had since evolved into 

Windows 2000 and then XP, became mainstream. (Yes, 

Windows 9x ran 32-bit applications, but it was a hybrid 

OS that ran on a 16-bit DOS foundation, which was one 
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of the reasons it was so unstable.) 64-bit Windows 

became a reality in XP, and Vista was Microsoft’s first 

serious attempt to make 64-bit computing mainstream. 

I am sure more people will use Windows 7 64 bit 

because of the increasing demands for more RAM. The 

question is: how mainstream is 64 bit? 

 

1.2.2 How Mainstream is 64 bit? 

While 64-bit 7 can run most 32-bit applications without 

a problem, it’s not compatible with 32-bit hardware 

drivers or 32-bit utilities like Windows Explorer 

extensions (e.g., context menu add-ons.) This means 

you need a native 64-bit driver for every device on your 

PC; finding support for all your hardware may be a bit 

of a challenge, at least on older computers 

 

1.2.3 Is there a Performance Increase? 

Now, 64-bit software running on 64-bit Windows has 

been known to run as much as 10% faster, which 

illustrates the other reason—aside from memory 

addressing—that people find 64-bit 7 alluring. Just be 
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prepared for lackluster industry support, at least for 

the next few years until Microsoft releases a 64-bit-only 

OS. 

 

1.3 Install Windows 7  

Now you’ve decided which version of Windows 7 to 

use, you’ll want to get it installed on your PC. You have 

three options: 

 Upgrade from Windows Vista 

 Dual boot with XP or Vista 

 Install Windows 7 from scratch 

Learn how to do each of the above in this section. 

 

1.3.1 Upgrade to 7 from Windows Vista 

Upgrading is the easiest option of the three. However, 

upgrading can take a long time. To upgrade to 

Windows 7 from Windows Vista, do the following: 

1. Insert the Windows 7 DVD into your DVD-ROM 

drive 
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2. Click Run setup.exe from the Autoplay menu 

 

3. Click Install now on the Install Windows screen 
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4. Setup will begin by copying files to your 

computer 

 

5. I recommend you get updates online before 

upgrading Windows 
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6. Accept the license terms and click Next 

 

7. Now click Upgrade and follow the instructions. 

You may get a compatibility report, which will help you 

determine what may not work properly after the upgrade. 
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1.3.2 Dual Boot Windows XP/Vista with 7 

Dual booting Windows is the most challenging of the 

three options; however, making it work can be very 

rewarding. The process of creating a dual boot 

environment differs from Windows Vista to XP. Please 

follow the instructions according to which version of 

Windows you are currently using.  

To run two operating systems on your computer, you 

will need to add a second partition. If you are not 

familiar with adding a partition, you can learn how in 

this section. 

 

1.3.2.1 Dual Boot Windows XP with Windows 7 

You will need third party software to create a second 

partition for Windows 7. Once you have created the 

partition, you may install Windows 7 on it. 

Creating a New Partition 

To create a second partition on your hard drive in 

Windows XP, do the following: 

1. Download the GParted live CD here 

http://gparted.sourceforge.net/download.php
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2. Burn the image to a CD, reboot your computer, 

and boot from the CD. (How to burn an ISO to a 

disc) 

3. Once you’ve booted into GParted, create a 

partition for Windows 7 (16 GB+ recommended) 

(How to create a partition with GParted) 

4. Refer to the Install Windows from Scratch 

section of this chapter to learn how to install 

Windows 7 on your newly created partition. 

 

1.3.2.2 Dual Boot Windows Vista with Windows 7 

Windows Vista natively manages partitions; you will 

need to create a second partition for Windows 7. Once 

you have created the partition, you may install 

Windows 7 on it. 

Creating a New Partition 

To create a second partition on your hard drive in 

Windows Vista, do the following: 

1. Press the Start button, right click Computer, and 

select Manage 

http://mintywhite.com/tech/windows-7/burn-the-windows-7-iso-to-a-dvd-how-to/
http://mintywhite.com/tech/windows-7/burn-the-windows-7-iso-to-a-dvd-how-to/
http://mintywhite.com/tech/windows-7/burn-the-windows-7-iso-to-a-dvd-how-to/
http://www.howtoforge.com/partitioning_with_gparted
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2. In the left pane, click Disk Management 

 

3. Now create a new partition by shrinking a 

previous volume. Right click on the partition and 

select Shrink Volume 
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4. Input the size, in MB, you want to shrink the 

partition by (16 GB = 16,384 MB) 

 

5. Now right click the free space and click New 

Simple Volume… 

 

6. Click Next 
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7. Select the volume size and click Next 

 

8. Assign a letter to the drive and click Next 
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9. Format the drive as NTFS, give it a label, and 

click Next 
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10. Click Finish 

 

11. Refer to Install Windows from Scratch to learn 

how to install Windows 7 on your newly created 

partition. 

 

1.3.3 Install Windows from Scratch 

Whether you are installing Windows 7 on a blank hard 

drive or a newly created partition, the procedure is the 

same.  

To install Windows 7 from scratch, do the following: 
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1. Turn your computer on, insert the Windows 7 

DVD, and restart your computer 

2. Press the necessary key to initiate booting from 

your DVD (usually ESC or F12.) If you are unsure 

how to do this, please refer to your 

manufacturer’s website or computer’s manual. 

3. Windows will now load the installation files. 

 

4. Click Install now 
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5. On the Get important updates for installation 

page, I recommend getting the latest updates to 

help ensure a successful installation and protect 

your computer against security threats. You need 

an Internet connection to get updates 

6. On the Please read the license terms page, if you 

accept the license terms, click I accept the 

license terms. (You must accept to continue the 

installation.) 

7. On the Which type of installation do you want? 

page, click Custom 

8. On the Where do you want to install Windows? 

page, do one of the following 

a. If you don't want to specify a partition to 

install Windows on, or create partitions on 

your hard disk, click Next to begin the 

installation 

b. OR If you already have another existing 

partition with enough free space and want 

to install Windows 7 on that partition to 

create a multi-boot configuration, select 



23 | 7  P O C K E T  G U I D E  

Getting Started 

 

the partition you want to use, and then 

click Next to begin the installation. (Be 

sure to install Windows 7 on a different 

partition from where your current version 

of Windows is installed.) 

9. Windows will take some time to install, so be 

patient 

 

10. Your computer will restart several times during 

the process. Be sure to leave the DVD in the 

drive and let Windows take care of itself 
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11. After some time, Windows will now be installed. 

If you are running a dual boot, you should have 

the choice of either version of Windows when 

you turn your computer on. 

 

1.4 About the Windows Registry 

Throughout this book, some guides require you to 

access the Windows Registry and make changes. I try 

to make executable registry hacks in most cases, but it 

can be fun to script or create your own registry files. 

Before doing anything with the Windows Registry, you 

should know what the registry is, how to back it up, 
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how to restore it to a previous state, and how to add 

keys and values. 

 

1.4.1 What is the Windows Registry? 

Think of the Windows registry as a control center for 

your computer. Windows settings, individual program 

settings, and other important configuration 

information are stored here. 

 

1.4.2 Access the Windows Registry Editor 

To access the Windows Registry, press the start button, 

type regedit, and press Enter. 

 

The registry is made up of the following components: 

 Keys 

 Subkeys 

 Values 
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1.4.3 Add Keys or Values 

In some of the tutorials in this book, you will need to 

create a new key or value. 

 

1.4.3.1 Add a New Key 

To add a new key, do the following: 

1. Right click on the parent key 

 

2. Select New > Key 

 

 

 

3. Follow the guide’s instructions for what key 

name to assign 

 

1.4.3.2 Add a New Value 

To add a new value, do the following: 

1. Navigate to the key that you want to add a value 

to 
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2. Right click in the blank space of the right pane  

 

3. Select New > xx (Where xx is the value specified 

in the guide) 

 

 

 

4. Follow the guide’s instructions for what value to 

assign 

 

1.4.4 Back up the Registry 

To back up the registry, please refer to the Back up 

Your Data chapter. 

 

1.5 About the Group Policy Editor 

Group Policy is a feature of Microsoft Windows that 

provides centralized management and configuration of 

computers. 
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Please Note: The Group Policy Editor is not included 

with every version of Windows 7 and is currently only 

available in Windows 7 Ultimate. 

 

1.5.1 Access the Group Policy Editor 

Press the start button, type gpedit.msc, and press 

Enter. 

 

 

1.5.2 Work with the Group Policy Editor 
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To enable options (as directed in any of the guides), 

double click on the specified option in the right-hand 

pane, and change the setting to Enabled. 

 

 

1.6 You Are Ready to Begin 

You made it this far and now you are ready to begin. 

As a brief recap, you learned the requirements of 

Windows 7, the version to install, and how to install 

your chosen version. You also learned about the 

Windows Registry and the Group Policy Editor. I 

strongly suggest you review the Back up Your Data 

chapter, but you are now free to explore the book. 
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2.0 Back up Your Data 

 

 

 

f you are not familiar with data backup or currently 

choose not to back up your files, please read this 

chapter. Making changes to your computer brings a 

certain level of risk. This risk is alleviated greatly when 

you make backups that are timely, complete, and 

functional. 

If you are one of the lucky people who have never lost 

a file on your computer, congratulations; however, this 

chapter is definitely for you. If you have lost files 

before – yep that’s you – then you should review this 

chapter too before you begin.  

   In this chapter, you’ll learn how to use Backup and 

Restore, backup and restore your registry, and how to 

recover lost files. 

 

I 
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2.1 Backup and Restore 

Backup and Restore – bundled with Windows 7 – is an 

excellent tool, which allows you to backup and restore 

either your files or an image of your operating system. 

 

2.1.1 Launching Backup and Restore 

To launch the Backup and Restore Center, do the 

following: 

1. Press the Start button and type Backup 

 

2. Select Backup and Restore 

 

2.1.2 Backing up Your Files 

To backup your files, do the following: 

1. Click Set up backup…  
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2. Windows will now prepare your system for 

backup  

 

3. Choose a backup destination and click Next 

 

4. I recommend you choose your files to backup. 
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5. Select the files you want to backup. You may 

include a system image, which will save your 

Windows settings as they are. This can be 

restored if something goes really wrong. 

 

6. Review your backup settings 
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7. Set the frequency of backup 

 

8. Windows will now backup your files 

 

 

2.1.3 Restoring Your Files 

Launch Backup and Restore and click Restore Files. 

Locate the medium your files are stored on and follow 

the instructions to get your previously backed up files 

back. 
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2.2 Back Up and Restore the Registry  

Some guides in this book will require you to change 

values in your registry. If you make a mistake and 

don’t correct it, you may find your computer is not as 

functional as it was before. To protect yourself from 

any mistakes, you need to backup your registry. To 

back up and restore your registry, do the following: 

 

2.2.1 Back up the Registry 

To back up the Windows registry, do the following: 

1. Press Start and type regedit 

 

2. Left click Computer in the left pane 

 



7  P O C K E T  G U I D E  | 38 

Back Up 

3. Go to File > Export 

 

4. Save the file (for extra precaution, save the file to 

a USB thumb drive) 
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2.2.2 Restore the Registry 

To restore your registry from a backup, do the 

following: 

1. Press Start and type regedit 

 

2. Left click Computer in the left pane 

 

3. Go to File > Import 

 

4. Click your backup file and click open 
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2.3 Create a System Recovery Disc 

If Windows 7 goes wrong, you can attempt a repair, at 

boot up, to see if the problem can be fixed. If you 

don’t have access to a Windows 7 disc, you can create 

a system recovery disc. The system recovery disc 

cannot be used to install Windows, but it can be used 

to fix common problems that prevent Windows from 

booting. 

 

To create a system recovery disc, do the following: 
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1. Press the Start buttom 

2. Type Backup 

 

3. Select Backup and Restore 

4. In the left column, click Create a system 

recovery disc 

 

5. Select your DVD drive and click Create disc 
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6. Wait for the disc to burn 

7. Test the disc by rebooting your PC with the disc 

in the drive. Boot from the optical drive and 

ensure the disc works.  

8. Save the recovery disc in a safe place 

 

2.4 Recovering Lost Data on Your Drive 

If you lose your data, be sure to check the recycle bin 

first. If there are no files in the recycle bin, there is still 

hope. Even though your files are deleted, the data may 

still be recoverable because the reference to the file 

has simply been deleted and not the data itself. As 



43 | 7  P O C K E T  G U I D E  

Back Up 

long as your file has not been overwritten, you have a 

chance at recovery.  

After trying many file recovery programs, I’ve decided 

Recuva is by far the best.  

Recuva (pronounced “recover”) is a freeware Windows 

utility to restore files that have been accidentally 

deleted from your computer. This includes files 

emptied from the Recycle bin as well as images and 

other files that have been deleted by user error from 

digital camera memory cards or MP3 players. It will 

even bring back files that have been deleted by bugs, 

crashes and viruses! 

http://www.recuva.com/download
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3.0 Security 

 

 

 

ne of the most important ways to protect 

yourself, when you are using your computer, is to 

be in control of security. There are so many threats out 

there that it is important to be proactive and protect 

your computer. 

In this chapter, you will learn how to choose an anti-

virus program, how to take ownership of your files, 

how to encrypt your sensitive data, and how to protect 

your privacy in Windows Media Player 11. There is so 

much you can do to protect yourself, but these guides 

should help you gain more control and help you know 

how to make good choices when using your computer. 

 

 

 

O 
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3.1 Choose an Anti-virus Program 

To protect yourself, you must have an anti-virus 

program. A virus is designed to disrupt the normal 

operation of your PC and can be costly: both in your 

time and repairs that need to be made to recover your 

system.  

Microsoft currently supplies a list of all vendors whose 

software works with Windows 7. Of the current 

software, I recommend AVG. 

 

3.2 Add Take Ownership to Context Menu 

Many folders in 7 are protected from changes and 

require administrative approval to change every time. 

Sometimes this can become tedious, so I’ve created a 

registry hack you can use to take ownership of select 

files. 

1. Download TakeOwnership.zip 

 

2. Add Take Ownership to your context menu by 

merging (double click) InstallTakeOwnership.reg 

into your windows registry 

http://www.microsoft.com/windows/antivirus-partners/windows-7.aspx
http://www.microsoft.com/windows/antivirus-partners/windows-7.aspx
http://www.microsoft.com/windows/antivirus-partners/windows-7.aspx
http://mintywhite.com/images/techtips/0804/10takeowner/TakeOwnership.zip
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Remove Take Ownership from your context menu by 

merging RemoveTakeOwnership.reg into your registry. 

 

3.3 Encrypt your USB/HDD Data 

Do you have data on your USB drive that could be 

accessed by someone if they found your key drive? Do 

you have sensitive data that you need to protect, but 

don’t want to pay for expensive software? TrueCrypt 

was designed for you and in this section you’ll learn 

how to use it.  

This guide is written for TrueCrypt 4.3a, but newer 

versions should operate in a similar fashion. 

I will refer the media as a “USB key drive” throughout 

this tutorial. If you are encrypting your hard disk drive, 

simply replace this phrase with “hard disk drive” – the 

procedure is identical. 

Final word: do not encrypt the entire drive your OS is 

stored on. You may encrypt parts of the drive, but not 

system files. 
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3.3.1 Download TrueCrypt 

1. Download TrueCrypt 

 

2. Run the installer 

 

3. When prompted, select Extract and click Next 

 

4. Extract the files to your USB key drive in a folder 

named TrueCrypt 

 

You can delete other files in the directory if you wish. 

Ensure you keep the following four files as depicted in 

the above figure. 

 

3.3.2 Encrypt part of your USB drive 

1. Run TrueCrypt.exe 

 

2. Once loaded, select a drive letter that will 

become the encrypted volume (the drive letter of 

your USB drive won’t change - but will show as 

two different drive letters when you complete 

this tutorial) 

 

3. Press Create Volume. Your USB drive will still 

keep its letter (i.e. “R”), but it will be split into 

http://www.truecrypt.org/downloads.php
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two virtual drives (so the encrypted data will 

appear as a “W” drive in Computer after you 

finish the setup.) 

 

4. Now select Create a standard TrueCrypt volume 

and click Next 

 

5. The next screen will ask you where you want to 

store the volume. Save a file named Container in 

the Truecrypt folder on your USB thumb drive 

and click Next 

 

6. Select the size of the encrypted volume (I 

suggest you use 1/2 the size of the drive) 

 

7. Create a secure password 

 

8. Now select Format and your Container will form 

 

9. After a confirmation message, click Exit 

 

3.3.3 Verify Your Encrypted Drive Works 

1. Go to your Computer and look for a “W” (or letter 

you chose) drive. It’s not there; good news! 

 

2. Open TrueCrypt 

 

3. Select the drive letter you chose in the previous 

steps 
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4. Click Select File and find your Container you 

created 

 

5. Click Mount 

 

6. Type in your password and press OK and your 

volume will mount 

 

7. Go to Computer and your drive will be there 

When you are done, go back to TrueCrypt and select 

Dismount. Congratulations, you now have your data 

encrypted on your USB drive. 

 

3.4 Maximize Privacy: Windows Media 

Player 11 

Personally, I like to ensure maximum privacy when 

using my computer. There are many programs that 

gather and send data; however, I will focus on Windows 

Media Player 11 because this is bundled with Windows 

7. This section will show you how to ensure maximum 

privacy in WMP11. 
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3.4.1 Configuring Privacy When Setting up WMP11 

for the First Time 

To configure privacy settings, when setting up WMP11 

for the first time, do the following: 

 

1. Click on the Windows Media Player icon on the 

Superbar 

 

 

2. Select Custom Settings and click Next 
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3. Adjust the privacy options accordingly. Review 

the screenshot, below, for my recommendations. 

Click Next 

 

4. Choose whether or not to make Windows Media 

Player your default media player. Click Finish 
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Your privacy is now protected when viewing and 

listening to media. 

 

3.4.2 Configuring Privacy after WMP11 is Set Up 

To configure privacy settings, after WMP11 is already 

set up, do the following: 

1. Click on the Windows Media Player icon on the 

Superbar 

 

2. On the Windows Media Player screen, Press the 

ALT key, and click Tools > Options… 
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3. Under the Privacy tab, configure your privacy 

settings. Review the screenshot, below, for my 

recommendations. Click OK 
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Your privacy is now protected when viewing and 

listening to media. 
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4.0 Windows 7‟s New 

Features 

 

 

 

indows 7 is packed with a whole host of new 

features. In this chapter, we‟ll take a look at 

some of these new features and how they can help you 

work more efficiently on your computer. While this is 

not an exhaustive break down of each feature, my 

hope is to both bring awareness of what Windows 7 

has to offer and inspire you to make the most of what 

is on offer. 

Some of these features, and others, are explained in 

more detail later in this book. 

 

 

 

W 
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4.1 Libraries 

Libraries are special folders, which aggregate your 

current media folders into one. For example: if you 

have three video folders (e.g. Movies, TV Shows, and 

Camera Videos), you can merge them into one, and 

have quick access to all your files at once. Public 

folders will also be merged into your files so your 

whole network can have seamless access to public 

files. This feature is particularly useful if you have a 

home media server and want to access the media on 

the server without navigating to mapped drives. 

Figure 1 shows the Libraries view, which gives you 

quick access to your documents, music, pictures, 

videos, and more. 

 

Figure 1: Windows 7’s libraries 
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Figure 2 shows an example of a library, which contains 

two different folders. A library can contain many 

folders from different locations including network 

locations. 

 

Figure 2: Libraries can contain many different folders  

 

 

4.2 AeroSnap and AeroPeek 

AeroSnap and AeroPeek are two features, which help 

you work more efficiently in Windows 7. Both features 

work well with Aero enabled; however, AeroSnap will 

work regardless of Aero running.  

4.2.1 AeroSnap 

AeroSnap is used to “dock” your windows to a side of 

the screen. If you‟ve ever wanted to compare two 

windows side by side, this is the feature you‟ve been 

waiting for.  
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Simply drag the window you are using to the left or 

right hand side of the screen. The window will then 

“snap” to that side of the screen, as shown in figure 3. 

You can also drag a window to the top of the screen to 

maximize it. 

 

Figure 3: AeroSnap “snaps” your windows to screen edges  
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4.2.2 AeroPeek 

AeroPeek helps you take a “peek” at your desktop by 

moving the mouse to the bottom, right-hand side of 

the screen. This feature helps you regain focus. Figure 

4 shows an example of AeroPeek in action. 

 

Figure 4: AeroPeek lets you “peek” at your desktop  
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4.3 Federated Search 

Federated search is used to search 

beyond the scope of your PC. Based upon 

OpenSearch and RSS, you may search 

remote repositories. You can create your 

own connectors, which is very easy 

because of the standard format used by OpenSearch. 

Figure 5 shows the Live Search connector after 

installation; you can now use Live Search directly from 

Windows Explorer. 

 

Figure 5: Use Federated Search connectors 
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4.4 Improvements in User Account 

Control 

One of Windows Vista‟s most criticized features is User 

Account Control (UAC.) Things need to be simple when 

using your computer and UAC seemingly added a new 

level of complexity that rarely helped the average user. 

Yes, asking a user if they want to take a specific action 

does add a level of security; however, if the user is 

clicking yes to everything, then this level of security 

becomes more of a stumbling block. 

Microsoft listened to the user and has greatly improved 

UAC. For example: the default user in Windows 7 (the 

one you set up when you installed Windows) has the 

setting enabled whereby self-made changes to 

Windows settings do not need a prompt. However, 

changes made by programs still need approval. Figure 

6 shows the details of this setting. Note the only 

warnings are given when changes to the computer are 

requested by the software you run on it. 
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Figure 6: Default UAC Setting 

To access UAC settings, do the following: 

1. Press the Start button, type UAC, and click on 

Change User Account Control Settings 

Currently, there are four options are offered when 

deciding on the level of security set by UAC. These 

options are range from Never notify to Always notify. 

Microsoft isn‟t the only one that made changes; other 

companies have built their software to work with UAC 

so there will be much less compatibility issues by the 

time Windows 7 rolls around. 
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4.5 BitLocker To Go and Biometric 

BitLocker encrypts your drives so others cannot access 

them without a password. Two new and exciting 

features in Windows 7 are BitLocker To Go and 

BitLocker Biometric. The following is an explanation of 

both of these features: 

 

4.5.1 BitLocker To Go 

BitLocker To Go encrypts the data on your portable 

media. With an increasing number of key drives at our 

disposal, loss of sensitive data is becoming more of a 

threat. In this guide, you‟ll learn how to encrypt your 

thumb drive with BitLocker To Go, how to verify the 

data is encrypted and how to remove encryption from 

your drive. 

 

4.5.1.1 Encrypting Your Thumb Drive 

To encrypt your thumb drive, do the following: 

1. Plug your thumb drive into a USB port 
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2. Click the Start button, type BitLocker, and click 

on BitLocker Drive Encryption 

3. Next to your thumb drive, click Turn on BitLocker 

 

4. If your thumb drive is compatible, BitLocker will 

prepare it for encryption 
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5. Choose a password and click continue 
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6. Either save your recovery key (used if you forget 

your password) or print a copy of it out 
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7. If you save the file, ensure the file is stored 

somewhere safe 

 

8. Click Next 
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9. Confirm your chosen settings and password and 

click Start Encrypting 

 

10. Your drive will now be encrypted 
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11. If you have a large thumb drive, this may take 

a long time 

 

 

4.5.1.2 Verifying Your Data is Encrypted 

When protecting your data or anything you own, it is 

important to ensure the protection actually works. I 

took my thumb drive out of the Windows Seven 

machine and put it in a Vista machine. You should do 

the following too, to ensure your data is protected. 

 

Please note: If you check the drive in an older version 

of Windows, you will need either XP SP3 or Vista SP1 or 
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above to read the encrypted drive. Other operating 

systems will recognize the drive as an unformatted 

drive. 

To verify your data is protected, do the following: 

1. Put your thumb drive in another PC and try to 

open the files. You should see a BitLocker setup 

file, which shows BitLocker is not installed on 

the computer you‟re testing on. If you have 

BitLocker installed on the machine, you will be 

prompted for a password (see the next step.) 

 

2. If you have BitLocker installed on the PC you are 

testing on, you will be prompted for your 

password 
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3. Enter your password to get to your data 

 

4.5.1.3 Removing BitLocker Encryption 

If you would like to decrypt your drive, do the 

following: 

1. Plug your thumb drive into a USB port 

2. Click the Start button, type BitLocker, and click 

on BitLocker Drive Encryption 
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3. Next to your thumb drive, click Turn Off 

BitLocker, and click Decrypt Drive 

 

4. This will take some time 

 

5. Your drive is no longer encrypted 

Now you are familiar with Windows 7‟s built-in feature, 

which helps you protect your data. 
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4.5.2 BitLocker Biometric 

BitLocker Biometric protects your computer via 

fingerprint credentials. If you don‟t currently have a 

fingerprint scanner on your laptop, I am sure, by now, 

you‟ve seen someone with a laptop that does this. 

BitLocker Biometric provides native support for logon 

authentication for Windows and also comes with an API 

that software vendors can use to protect access to 

programs. Expect to see more and more programs 

using this feature. Figure 7 shows a list of biometric 

devices attached to your computer.  

 

Figure 7: List of Biometric devices 

 

You can assign any finger when enrolling a biometric 

device as shown in figure 8. 
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Figure 8: Assign a finger to your biometric device  

 

BitLocker biometric looks to be an exciting feature that 

will become more integral to our computing habits in 

the near future. 

 

4.6 The Windows HomeGroup 

Setting up a home network can, at times, be 

complicated. In the past, Windows XP and Vista haven‟t 

done a great job at guiding you through the setup 

process. As the average household houses more than 
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one computer these days (no source, but I‟m just 

assuming this is the case), home networking is 

becoming more of a mainstream need. With PCs 

running Windows 7, a home network is easier to setup 

and a lot more useful. HomeGroup makes it easier to 

connect to other computers and devices on a wireless 

home network, so you can share files, photos, music, 

printers, and more throughout your home network. 

HomeGroup is strictly a feature of Windows 7, so you‟ll 

need to have at least two PCs running Windows 7. Once 

you've set up a HomeGroup, you can use the Network 

and Sharing Center to choose what you share with 

other HomeGroup members. 

 

4.6.1 Setting up Your HomeGroup 

Figure 9 shows the location specification of the current 

network you are connected to. When you select Home 

as your network, Windows will start modifying settings 

to enable resource sharing. 
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Figure 9: Selecting the location of your network 

 

After Windows prepares your network, you will be 

asked to decide what you want to share on the 

network. Choose from Pictures, Documents, Printers, 

Music, and Videos (Figure 10.) When you click Create 

Now, your network will be set up appropriately with 

the choices you made (Figure 11.) 
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Figure 10: Selecting shared items for your HomeGroup  

 

 

Figure 11: Windows prepares your HomeGroup for you  
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Now your HomeGroup is nearly set up. All you need is 

the password, which allows other computers, running 

Windows 7, to connect to your HomeGroup. Figure 12 

shows the screen where you are given your password. 

You can view this password whenever you need by 

going to the Network and Sharing Center. 

 

 

Figure 12: Your HomeGroup password 
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4.6.2 Joining Your HomeGroup with Another PC 

Now you‟ve set up your HomeGroup, you may join 

other computers to it. To join your current 

HomeGroup, go to your second PC and do the 

following: 

1. Connect to the same network (wireless or wired) 

the HomeGroup is set up on. 

2. You will be prompted to join the HomeGroup. 

Click Join Now 

 

3. Type in your HomeGroup password 
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4. Now you can decide what you would like to share 

on the HomeGroup 

 

5. After sharing your files, you are now part of the 

HomeGroup 
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4.6.3 Accessing Files Shared on the HomeGroup 

To access files shared on your HomeGroup, do the 

following: 

1. Open Windows Explorer (Winkey+E) 

2. In the left-hand pane, you should now see your 

HomeGroup files. Click on the links to access the 

shared data. 
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4.7 Device Stage 

Device Stage is a new technology that helps you 

interact with any compatible device connected to your 

computer. Device Stage lets you see device status and 

run common tasks. This a current list of products that 

take advantage of Device Stage. 

Device stage is designed to take the pain out of adding 

new devices to your computer and have them working 

almost instantly. Many people wonder why it is so hard 

to recognize a device plugged into a machine. Simply 

put, Windows cannot interact with all these devices 

instantly because they all work differently; Windows 

needs drivers for these devices to communicate with 

them properly. Device stage will install drivers when 

you plug a new device in or go out to Windows Update 

to get the necessary files. I am very impressed with 

Device stage. I plugged in my LG TV and not only did it 

recognize it as such, but it changed my resolution to 

the TV‟s native resolution of 1920 x 1080 without my 

clicking the mouse once. 

http://www.microsoft.com/windows/windows-7/devices.aspx
http://www.microsoft.com/windows/windows-7/devices.aspx
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Essentially, device stage should alleviate the need for 

bulky third-party applications that were required, in the 

past, to access your devices. 

 

4.8 Action Center 

Windows Action Center is an improved version of 

Vista‟s Security Center. The action center alerts you to 

problems with your PC and lets you know how you can 

resolve them. Notifications are delivered through the 

notification area (Figure 13.)  

 

Figure 13: Action Center notifications 
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Figure 14 shows the action center, which gives you 

alerts about virus protection settings, Windows update, 

and more. 

 

Figure 14: The Windows Action Center 

The Action Center deals with both security and 

maintenance. 
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4.8.1 Action Center – Security 

The security section of the Action Center deals with 

antivirus and spyware protection, firewall settings, 

UAC, and more. This is your one-stop solution to 

ensuring your computer is secure. Figure 15 shows the 

settings that are monitored. 

 

Figure 15: Action Center - Security alerts 
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4.8.2 Action Center – Maintenance 

In a similar fashion to the security section, the Action 

Center also ensures your computer is maintained and 

deals with backup, updates, and more. Figure 16 

shows the areas the Maintenance section is responsible 

for. 

 

Figure 16: Action Center - Maintenance alerts 
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4.8.3 Action Center – Troubleshooting 

One great feature bundled with the Action Center is 

troubleshooting. If you are having problems with your 

computer, open the troubleshooting component and 

Windows will run tests to determine why the problem 

exists and how it can be fixed. 

To test the troubleshooter, I decided to let Windows 

find out why I cannot run Aero. To troubleshoot a 

problem, apply the following steps: 

1. Press the Start button, type action, and click on 

Action Center 

 

2. Scroll down and click on Troubleshooting 
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3. Locate the issue you are having (in this case 

Display Aero desktop effects) 

 

4. Windows will now determine why you are having 

the problem 
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5. In this case, Windows determined I need to 

update my drivers 

 

6. Windows may continue to detect problems 
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7. Windows has found the exact problem: my 

graphics card (a generic VMWare card) is not 

compatible with Aero 

 

The Action Center is great and a move in the right 

direction. Computers will never completely fix 

themselves, but letting you know what the problem is 

helps greatly. 
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4.9 Internet Explorer 8 

Internet Explorer 8 is Microsoft‟s latest web browser, 

which comes packed with many new features. Below is 

an explanation of how to get IE8 up and running and a 

breakdown of some of the best features. 

 

4.9.1 Configuring IE8 for the First Time 

When you first launch IE8, you are presented with some 

questions. I‟ve put together a simple step by step and 

explanation of the initial setup as follows: 

1. Click on IE8 on the Superbar 
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2. You will see the initial setup screen. Click Next 

 

3. Choose whether you want suggested sites or not 
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4. I recommend choosing Custom Settings 

 

5. If you want a custom provider, select Show me a 

webpage after setup to choose more search 

providers 
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6. If you want to set up more accelerators, select 

Show me a webpage after setup to choose 

more Accelerators 

 

7. Smart Screen Filter helps protect you from 

malicious websites 
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8. You can choose to use compatibility updates. 

These updates make websites, designed for 

older browsers, look better. 

 

9. Click Finish and you are ready to go 

 

4.9.2 Web Slices 

Web slices are used to save „snippets‟ of your favorite 

web pages and show you just the parts you want to 

see. These can be really useful when you follow some 

websites that are updated frequently. See the selection 

of Web Slices here. 

http://www.ieaddons.com/en/webslices/
http://www.ieaddons.com/en/webslices/
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An example of a Webslice: MSN News Slideshow 

 

4.9.3 Accelerators 

Accelerators help you perform common tasks, such as 

online search and mapping, with ease. Download 

accelerators here and install the ones you want to use. 

Then, when you are browsing, simply highlight some 

text and click the accelerator arrow to perform a task. 

http://www.ieaddons.com/en/accelerators/
http://www.ieaddons.com/en/accelerators/
http://www.ieaddons.com/en/accelerators/
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Adding new accelerators is easy; select the accelerator 

you want and click Add. 
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4.9.4 Quick Tabs 

Quick tabs show you all currently open tabs at a glance 

to help you select the page you need. 

 

 

4.9.5 Improved Search 

Search has been greatly improved, with smart 

suggestions and even inline search – a feature I‟ve 

taken for granted in Firefox. 

Enter your query in the search bar and receive 

customized results and suggestions depending on the 

current search engine in use. 
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Inline search helps you find the key phrases you are 

looking for, without the hassle of a pop-up search box. 

 

 

4.9.6 InPrivate Browsing 

InPrivate Browsing helps prevent Internet Explorer from 

storing data about your browsing session. This 

includes cookies, temporary Internet files, history, and 
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other data. Toolbars and extensions are disabled by 

default. 

 

 

4.9.7 Automatic Crash Recovery 

If IE8 crashes while you are using it, you won‟t lose 

your current tabs; IE8 recovers your browsing session 

automatically. 
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4.10 Geographic Location 

Many programs in Windows 7, such as Firefox, will 

utilize your geographic location. This location will be 

used in a variety of ways including letting people know 

where you are when you send emails and take pictures 

etc. 

To set your default geographic location, do the 

following: 

1. Click the Start button, type loc, and click on 

Default Location 
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2. From this screen, you may set you default location 

settings 

 

3. When you are done, click Apply 

Now you are ready for maximum utilization as more 

location-aware programs and services are released. 
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4.11 In Conclusion 

Windows 7 has some excellent new features. Yes, there 

are even more new features than I previously listed in 

this chapter; however, I feel ones I‟ve covered are the 

most exciting and useful. 

Windows 7 is Microsoft‟s best operating system to 

date; I am in no doubt about this statement. The future 

is bright. 
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me – listed below: 

 Website: http://mintywhite.com  
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